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Monochrome definitions
The International Federation of Photographic Art (FIAP) deYines monochrome
images as:
A black and white work Yitting from the very dark grey (black) to the very clear
grey (white) is a monochrome work with the various shades of grey. A black
and white work toned entirely in a single colour will remain a monochrome
work able to stand in the black and white category; such a work can be
reproduced in black and white in the catalogue of a salon under FIAP
Patronage. On the other hand a black and white work modiYied by a partial
toning or by the addition of one colour becomes a colour work (polychrome) to
stand in the colour category; such a work requires colour reproduction in the
catalogue of a salon under FIAP Patronage.
The Photographic Society of America (PSA) deYines monochrome images as follows:
An image is considered to be Monochrome only if it gives the impression of having
no color (i.e. contains only shades of gray which can include pure black and pure
white) OR it gives the impression of being a grayscale image that has been toned in
one color across the entire image. (For example by sepia, red, gold, etc.) A grayscale
or multi-colored image modiYied or giving the impression of having been modiYied
by partial toning, multi toning or by the inclusion of spot coloring does not meet the
deYinition of monochrome and shall be classiYied as a Color Work.
These deYinitions are rather wordy, but to put it simply - a monochrome image must
contain only one colour, but it can be any colour. Using the above deYinitions, the
following images would all be classiYied as monochrome:
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The following images would NOT be classiYied as monochrome because the image of
the girl has areas that are coloured and the landscape is a duotone image with blue
tones in the shadows and yellow tones in the highlights.
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Why convert images to monochrome?
By translating the colours into monochromatic tones it is possible to emphasise lines,
tones, contrasts, textures, composition, framing, selective focus, interactions between
image elements, etc., WITHOUT THE DISTRACTION OF COLOUR. This is illustrated in
the following images:

Removing the colours focuses attention on the interaction between the children and
makes it easier to remove some of the potential distractions (such as the leaves on the
ground and the crowd in the background].
Monochrome images allow the photographer to selectively emphasise the
compositional elements that are important to the message that is intended to be
communicated by the image.

What makes a good monochrome
image?
It is easy to produce a monochrome image - a later section of this paper explains
several different ways of doing it. However, powerful monochrome images are usually
previsualized as monochrome images rather than the monochrome conversion being
an afterthought. Of course, good monochrome images will have all the usual strong
features - good composition, appropriate clarity, and so on, but the at the time of
capture and during processing the following factors are particularly important:
A good colour image: If you start with a poor quality colour image you will rarely
produce a good quality monochrome image. You will see later that successful
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monochrome conversions rely on translating colours into appropriates shades of grey,
so it is important to capture mages that have well deYined colours and no colour casts.
Tonal Contrast: Strong contrast helps to deYine shapes and bring out textures. WelldeYined whites (not over-exposed) and well-deYined blacks are critical in most
monochrome images. Controlling the dynamic range of your captured image is critical.
Separation of the subject from the background: Monochrome images rely on tonal
differences for separation (whereas colour images can use colour differences for
separation) - so clear backgrounds are often necessary.
Simplicity of composition: Images that have obviously strong or dominant
compositional elements such as shapes and lines can often be simpliYied and
strengthened by removing the colour.
Expression: Removing the colour from images of people (particularly portraits) can
concentrate attention on their expression and the emotional connection with the
viewer.
Texture: Textures created by contrast and by direction light can add depth and interest
to a monochrome image.
Shadows: In a monochrome image a shadow can often carry more visual weight (and
more interest) than in the colour original.
These concepts are illustrate later in this paper in the section on “Which Images Best
Suit Monochrome”.

Should I set my camera to
monochrome?
Most digital cameras will allow you to save monochrome images rather than colour
images to the memory card. Generally this is NOT a good idea. The main reason is that
the “Black and white” setting on most digital cameras records a JPEG Yile rather than a
RAW Yile. Recording RAW Yiles gives you better quality images and greater Ylexibility
when editing your images. Recording RAW Yiles also means that you have a colour
version of your images should you decide later that this is what you want.
The second reason for not setting your camera to monochrome is that the camera will
apply a standard conversion process to the colour information. It will convert all
images using the same ‘formula’. This may give satisfactory results of some images but
it is very unlikely to give the best results possible for all images, especially when the
content of the images is very different (some landscapes, some portraits, and so on).
Doing your monochrome conversions in an image editor such as Photoshop allows you to
use a conversion process that suits each individual image, and it gives you control over
how that conversion process is applied.
The problem with not having control over how your camera makes monochrome
conversions is illustrated with the following images:
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This is the original colour image.

This is the monochrome image
taken with “Camera 1”.

This is the monochrome image
taken with “Camera 2”. You can
easily see that the two cameras
treat the colours differently
when making the monochrome
conversion.

The beneYit of being able to control the monochrome conversion in your image editor
is illustrated with the following conversion of the colour image shown above:
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One possible monochrome
conversion in Photoshop.
You can see how the tonality
of some of the original
colours is very different from
that obtained ‘in camera’.

A third reason for not setting your camera to monochrome is that you will be throwing
away the colour information. You cannot get it back! If you decide later that you would
like a colour version of the image you will not be able to get it.

NOTE: Some digital cameras are able to record a RAW file and a JPEG file simultaneously.
By selecting this option and then selecting the “Black and White” option on the camera you
are able to record all the colour information in the RAW file and also save a JPEG version of
the monochrome image. You see a monochrome version of the image on the camera
preview screen. This can be useful if you know that you want to later produce a more
refined monochrome version of the image in your image editor.

Colour is the key to monochrome
The secret to being able to select the best process for a monochrome conversion and
apply that process skilfully is understanding colour and tone. So before considering
some speciYic conversion techniques I will review some basic ideas about colour and
tonal range.
Colours can be described by three characteristics - hue, saturation and brightness.
HUE: The name of the colour – e.g., red, green, blue, yellow, purple.
SATURATION: The intensity or depth of the colour – e.g., pale pink, vibrant red.
BRIGHTNESS or LIGHTNESS: How light or dark a colour appears.
Changing just one of these characteristics while keeping the other two constant makes
a big difference to what we see. For example, if we start with pure red:

(c) Roy Killen 2019

Monochrome Conversions

Page 6

Changing saturation

Changing lightness

Changing hue

You will see the importance of being able to control the hue, saturation and lightness of
colours in an image when we explore various techniques for monochrome conversion.
But Yirst we need to consider how image processors such as Photoshop deal with
colour information in an image Yile.
During digital processing, each pixel in an image is represented in the computer as
speciYic values of red, green and blue colour components (that’s why it’s called an RGB
image). Combining these colour components produces a spectrum of possible colours.
The perceived colour of any pixel depends on the intensity of each of the three
component colours (R, G and B) used to produce that pixel.
Red, green and blue are referred to as primary colours
and they have been chosen because of the particular
sensitivity of the human eye to light. (Some other colour
systems use different primary colours.) When two
primary colours of equal intensity are combined, the
only colours they can produce are the secondary
colours (cyan, magenta and yellow in the RGB system).
Combining the three primary colours in equal intensity
produces white. The absence of all colour produces
black.
The range of colours that can be reproduced when red,
green and blue of different intensities are combined is
called a colour space. The values of the hue and intensity that deYine red, green and
blue set the boundaries of the colour space (the limits to the colours that can be
reproduced in that colour space). The two most common colour spaces that you will
encounter in photography are called Adobe RGB (1998) and sRGB.
The total range of colours shown in the diagram on the next page represent the typical
limits of the human visible spectrum. As you can see in this image, the sRGB colour
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space is smaller than the Adobe RGB colour space (it contains fewer possible colours)
and the RGB colour space is smaller than the range of colours that humans can
typically see. This just means that
modern technologies, such as
monitors and printers, are not
capable of producing all the colours
that humans can see. The difference
is most obvious in the green areas of
the spectrum.
I will not go into the pros and cons
of capturing and processing images
in different colour spaces in this
tutorial. However you should be
aware that at the present time it is
only high-end (expensive) monitors,
printers and photographic papers
that are capable of reproducing
close to the full Adobe RGB
spectrum. For most of your
photographic work the Yinal print or
digitally displayed image will be
quite satisfactory in the sRGB colour
space.
When exploring colours in an image editor (such as Photoshop) you will Yind that the
intensity of each of the three primary colours (R, G and B) can have a value between 0
and 255 where 0 means none of the colour is present and 255 means the colour has its
maximum intensity. For example, whatever your monitor represents as “pure red” will
have R = 255, G = 0 and B = 0. Likewise, cyan will have R = 0, G = 128, and B = 128.
To experiment and see what colours are produced by different combinations of R, G
and B have a look at www.magicschoolbook.com/science/colourmix.html.

Tonal range
In any scene that you photograph, the difference between the darkest and brightest
areas in the scene is referred to as the dynamic range of the scene. In many cases
(because of the limitations of your camera or because of poor exposure choices) the
captured image will not include the full range of tones in the scene. When the tonal
range of the captured image is less than the dynamic range of the scene the image may
lack contrast and look ‘Ylat’. This is generally not desirable when you are producing
monochrome images so it is important to consider how you can maximise the tonal
range at the time of capture and when processing your images.
The easiest way to check the tonal range of an image is to look at the histogram of that
image. The histogram, whether displayed on your camera or in an editing program, is
simply a graph that shows the distribution of the brightness values of the pixels. Those
values can range from 0 (the blackest black) to 255 (the whitest white). The following
example shows how the brightness values of an image map onto its histogram.
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0

128

255

There is no ‘perfect’ histogram, it is always simply a way of representing whatever
tones are in the image. However, it is a useful way of quickly identifying whether or not
your image has an appropriate range of tones so that it is not seriously under-exposed
or over-exposed.
As an approximate guide, shadow areas that fall below about 15 on the histogram will
have no visible detail and highlight areas that fall above about 235 on the histogram
will have no visible detail.
Before considering how to convert any colour image to monochrome, it is important to
consider whether or not the image has an appropriate range of tones; that is, whether
or not it is correctly exposed. If necessary, the overall exposure and the black and white
points should be adjusted before a monochrome conversion is made.

(c) Roy Killen 2019

Monochrome Conversions

Page 9

Controlling colour in Photoshop
The secret to producing good monochrome images lies in being able to control
colour; it is not simply a matter of “getting rid of colour”. To control colour you need to
understand how programs such as Photoshop produce colour images.
Photoshop (and similar image editors) store colour information in CHANNELS. When
the colour mode is set to RBG, there are three channels, one each for the red, green and
blue colour information in the image that is being displayed. Each channel is effectively
a grayscale map that shows the intensity of the relevant colour (R, G or B) for each
pixel in the image.
Consider this simple image that has areas that are approaching “pure” red and green,
and a blue area that looks as though it could have considerable amounts of other
colours mixed in with it.

If we open this image in Photoshop and then open the Channels palette (from the
menu select Windows>Channels) we see the following:
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By viewing each channel separately (turn off the ”eye” for the channels you do not
want to be displayed) we can see how the colour image is made up of varying amounts
of red, green and blue.

RED channel

GREEN channel

BLUE channel

In each of the channels, light areas represent intense amounts of the relevant colour
and dark areas represent an absence of that colour. In the red and green channels there
are very bright areas corresponding to the intense amounts of red and green that we
saw in the colour image. However, in the blue channel the light areas are not nearly so
bright, which is what we expected since the “blue” area of the colour image is obviously
not “pure”. By looking at the red and green channels we can see that the “blue” areas of
the image contain a considerable amount of green (they are almost mid-grey in the
green channel) but very little red.
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At this stage in the journey towards producing monochrome images the following
points have been established:
• Each pixel in a colour image has varying amounts of red, green and blue.
• The colour information is stored in three channels.
• Each channel shows the distribution and intensity of the relevant colour.
• When the red, green and blue components in a pixel are equal, that pixel will be a

shade of grey; the more intense the colours the lighter the shade of grey.

We will now use this information to explore a range of ways of converting colour
images to monochrome images.

Monochrome conversion techniques
in Photoshop
Although the following notes are based on the use of Photoshop, many of them are
available in other image editors. If you understand the principles behind each
technique it should not be too difYicult to work out which techniques are possible in
your favourite image editor.
The techniques described here progress from the very simple to the more complex. As
a general rule, the more complex techniques are capable of producing better results
because they give you more control over the conversion process. However, there are
some images that convert quite well using the simple techniques. The basic rule is:

use a conversion technique that suits your image.

Method 1 - Convert to grayscale
To achieve this conversion, select Image>Mode>Grayscale from the menu.
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Photoshop will then combine the information in the red, green and blue channels in
the following way to produce a grayscale image and a new grayscale channel:

It is fairly obvious in this image that the green components of the original image
dominate the conversion process and the blue components have almost no effect. For
some images this may be what you want, but it rarely produces the best possible result.
Most importantly, this is a destructive process. The three colour channels (R, G and B)
are discarded immediately so there is no longer any colour information associated
with the image. If you save and close this grayscale image you cannot reverse the
process and get back to the colour image. Because there is no longer any colour
information available, your options for further adjusting the image are severely
restricted. This method of monochrome conversion is not recommended.

Method 2 - Desaturate
Desaturation means removal of colour and it is a simple process that is achieved by
selecting Image>Mode>Desaturate from the menu.
This process retains the R, G and B channels but they now all contain the same
information. You have NO control over how Photoshop makes this conversion. If the
image is saved, the colour information is lost and the process cannot be reversed.
Conversions made in this way generally produce poor results, often with very low
contrast, as shown in the following example.
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As you can see, the result is far from satisfactory and will almost never give the best
possible result.
To understand the importance of using conversion techniques that retain colour
information and give you control over how it is used, consider the following examples
of what happens when colours of similar hue, brightness or saturation are changed to
grayscale by either the desaturation or convert to grayscale methods.
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And if you still need convincing, consider what would happen if you simply
desaturated a multicoloured image in which the colours had similar levels of
brightness and saturation:

Original

Desaturated

In this case, all the desaturated colours finish up being the same shade of grey.
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On a ‘real’ images the result could be disastrous as these examples illustrate:

Original

Desaturated

Original

Desaturated
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Because of the limitations of the simple conversion processes described so far, it is
useful to consider conversion methods that do two important things:
1. Give you more control over the conversion process.
2. Retain the colour information so that the conversion process can be
reversed or adjusted at a later time.

Method 3 - Hue/Saturation adjustments
The Hue/Saturation adjustment can be activated in two ways, either from the menu or
from the Adjustments Panel. Activating it from the Adjustments Panel is preferred
because this creates an adjustment layer, whereas activating it from the menu means
the adjustments are made directly to the image and they become destructive (changing
the actual pixels rather than just changing the appearance of the image).

MENU

ADJUSTMENTS

Once the Hue/Saturation panel appears, moving the “Saturation” slider fully to the left
will desaturate the image and give the same result as that obtained with the
Desaturation method described previously.
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At Yirst, that might seem rather pointless, but there are two ways of gaining some
control over this conversion process. The Yirst is to leave the “Saturation” slider fully to
the left, then select a primary or secondary colour from the “Edit” drop down menu
and adjust the lightness of that colour. Each of the primary and secondary colours can
then be selected and their brightness adjusted independently of how the Yirst colour
was adjusted.
A couple of quick adjustments to the brightness of the reds, blues and yellows
transformed the previously dull ballon image to this:

Still not fantastic, but a big improvement over a simple desaturation.
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Another way of gaining more control over the conversion is to add a second Hue/
Saturation adjustment layer and use it to adjust the lightness of the various colours.

This gives a considerable amount of extra control over the monochrome conversion, as
illustrated in the following image that compares the results of using one or two Hue/
Saturation adjustment layers on the lorikeet image.

Single Hue/Saturation adjustment layer

Two Hue/Saturation adjustment layers - one

with saturation slider taken to -100.

to desaturate, one to adjust lightness of
individual colours.
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One advantage of experimenting with this method of conversion is that it helps you to
understand the relationship between the intensity of various colours and the tonality
of the Yinal image. The main problem with this approach is that it can become very
Yiddly, largely because the lightness adjustments of the various colours tend to interact
since areas that contain a lot of red often also contain a lot of yellow, areas containing a
lot of blue often have a lot of cyan, and so.
A further reYinement of this approach uses two Hue/Saturation layers to simulate he
effect of using a colour Yilter when capturing the image:

Selecting different Hue values on the bottom Hue/Saturation layer can have effects
such as this:

(c) Roy Killen 2019

Monochrome Conversions

Page 21

Method 4 - Lab Colour
This method converts you image from the RBG colour space to the Lab colour space.
The Lab colour space has three channels, one of which is the Lightness channel. The
conversion process is:
1. Select Image>Mode>Lab Colour
2. In the Channels panel select the Lightness Channel (if the Channels panel is
not open select Window>Channels from the menu).
3. Select Image>Mode>Grayscale to get out of the Lab colour mode.
4. You will be prompted to discard the other channels, so click OK.
The result of this process may be similar to Method 1 (convert to grayscale) but it
usually gives a better result.
The disadvantage of this method is that it is destructive (cannot be reversed) and you
have limited control over the conversion process. The result for the balloon image was
this:
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Method 5 - Gradient map
This is a simple way to maximise the tonal range in an image as you convert it. The
Gradient Map can be selected from the menu or applied as an adjustment layer (which
is recommended).

Either approach brings up the Gradient Map window. If the gradient that is showing is
not the black-to-white gradient simple click on the gradient to bring up the Gradient
Editor window. Then select the the black-to-white gradient by clicking on it.
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The Gradient Map has the effect of making the lightest pixels in the image white and the
darkest pixels in the image black. The lightness of the other pixels is then converted to
shades of grey in a linear fashion (equal changes in brightness correspond to equal
changes in the shades of grey). A typical result is:

Comparing this to what we would get by simply desaturating the colour image we can
see that the Gradient Map produces a much crisper image with more contrast.
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It is often worth applying a gradient map to give your image a little more ‘punch’ after
you have done an initial monochrome conversion by some other method.

Method 6 - Channel Mixer
We saw earlier that Photoshop stores colour information in three Channels (R, G and
B) and that the luminance values of that information can be used to create
monochrome images. For example, when you convert an image to grayscale Photoshop
combines 30% of the red channel luminance with 60% of the green channel luminance
and 10% of the blue channel luminance.
The Channel Mixer approach to monochrome conversion allows you to control how
much each of the three channels contributes to the Yinal monochrome image rather
than just accepting the Photoshop defaults for grayscale conversion.
This method of conversion can be very useful if, for example, one channel has more
noise than the others (typically the blue channel will have more noise than the red or
green channel) or if one channel has more mid-tone contrast than the others (typical of
the green channel). You simply add more of the channel that has the features you want
and less of the channel that has features that you do not want.
As usual, you can select the Channel Mixer from the menu or from the Adjustments
panel (which is recommended as it puts the Channel Mixer in an adjustment layer):

Whether you activate the Channel Mixer from the menu or create a Channel Mixer
adjustment layer the Channel Mixer panel opens. The Yirst thing to do in this panel is to
tick the “Monochrome” box.
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You will see
that by default
the “mix” is
40% red, 40%
green and 20%
blue (which is
different from
the 30:60:10
mix used as the
default for
grayscale
conversion).
You can change
this mix in any
way that you
want to and
observe the
effect on your
monochrome
image. For
example:

When you move one of the colour sliders to the right you lighten that channel. When
you move one of the colour sliders to the left you darken that channel.
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When you are adjusting the sliders to vary the amount of each channel that is being
used it is important that the sum of the red, green, and blue percentages is close to
100%. (Anything between about 85% and 115% is usually OK.) If the total is too high
the image will “wash out”. If the total is too low the image will be too dark.
You can adjust the overall brightness of the image with the "Constant" slider near the
bottom of the Channel Mixer panel.
The versatility of this method of monochrome
conversion is illustrated with following image.

Before attempting the conversion, it is important to
examine the individual channels. For this image we
can note several important things:
1. In the red channel the skin tones are very light.
2. In the blue channel the skin tones are relatively
dark.
3. The green channel has more mid-tone contrast and
better structure than either of the other channels.

We can now use our knowledge about the information in each of the channels to
construct a monochrome image in the style we want. And since we have the Channel
Mixer as an adjustment layer we are not locked in to any particular adjustment - we
can create as many versions of the monochrome image as we want without destroying
any of the information in the original image. Here are some examples:
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A natural looking result with good (but not extreme) contrast can be created with the
majority of the information coming from the green channel. For comparison, it is
shown against the same image simply desaturated.

If you wanted much lighter skin tones you could let the red channel dominate. This is
the sort of light, smooth skin tone you might want on an image of a child.

Note here that the blue channel value is
actually negative. The scales on the colour
sliders go from -200% to +200%. Don’t worry
too much about this, just remember that
moving any slider to the right increases the
contribution of that channel and lightens the
image; moving any slider to the left decreases
the contribution of that channel and darkens
the image.
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For a darker (grungy) look in this current example
I can let the blue channel dominate.
In this case I have used a negative value for the
red channel, and this also contributes to the much
darker skin tones.
The point to remember is that by controlling how
much of each channel is used in the construction
of the monochrome image you can create
whatever style of image you want.

If you want the monochrome image to look “natural” you have to understand
something about how the human eye responds to light of different colours.
Human eyes are more sensitive to green than red, and more sensitive to red than blue.
Because of this characteristic of human vision, when we look at a coloured image, some
colours appear brighter than others even
though they have the same luminosity.
If we want to make a monochrome
conversion that preserves this “natural” look
then we need to mix the channels in the ratio
of R = 30%, G = 59% and B = 11% (which is
why the default for the desaturation
adjustment is 30:60:10).
These colours all have the same luminosity
and saturation, but some appear brighten
than others.
The perceived differences in luminosity are
preserved if we use channel mixing with
R=30, G=59 and B=11. For example, yellow
appears to be the lightest colour and it
converts to the lightest shade of grey. The
blue appears to be the darkest colour and it
converts to the darkest shade of grey.
(c) Roy Killen 2019

Monochrome Conversions

Page 29

The 30:59:11 ratio is often a good starting point for a Channel Mixer greyscale
conversion but there may be speciYic reasons for changing it. That’s why it is always
important to examine the R, G, B channels carefully before starting the channel mixing
process. This point is illustrated in the following example.
This ‘natural’ ratio of channel mixing is illustrated in the following mage:

We can use a small section of this image to illustrate that when you use long exposures
and/or high ISO values there may be considerable noise in one or more of the
channels.
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The excessive noise in the blue channel is
very evident in this image, so keeping the
blue channel component to a minimum
in the monochrome conversion is
probably a good strategy.

Method 7 - Black and White Conversion
In early versions of Photoshop, the Channel Mixer was often the preferred method of
monochrome conversion because of the control it provided. With version CS3 of
Photoshop, Adobe
introduced a simpler
way of “mixing the
colours” to produce a
monochrome image.
It was known simply
as a “Black and White”
adjustment. As with
most other
conversion methods,
this one can be
activated from the
menu or as an
adjustment layer
(preferred).
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The Black and White adjustment panel allows the luminance of the three primary
colours and three secondary colours to be adjusted.
The default settings of the sliders are shown here:
R=40 Y=60 G=40 C=40 B=20 M=80
Each of the sliders can be set to ANY values from
-200 to +300 and there is no need to try to achieve
any particular total for the values.
Moving a slider to the right lightens that colour,
moving it to the left darkens that colour.
In addition to the default setting, there is an
“auto” setting that is designed to maximise the
number of shades of grey in the image. The
difference might be strong or subtle, depending
on the content of the image.
This method of monochrome conversion has
three main advantages over the Channel Mixer,
particularly for users not familiar with
manipulating channels - it is more intuitive than
channel mixing, it gives control over six colours
rather than just three colour channels, and there
is no longer any need to worry about trying to get
the 100% total that is recommended with channel mixing.
From the Black and White panel you can select from a range of in-built presets. You
Yind them by clicking on the window adjacent to “Presets”.
If you make custom settings that you want to be able to apply to other images you can
save those adjustments as a custom present.
Although the Black and White adjustment allows you to control the luminance
(brightness) of the primary and secondary colours it does not allow you to change the
saturation or hue of those colours. However, you can control the hue and saturation of
these colours by putting a Hue/Saturation adjustment layer in between the colour
layer and the Black and White layer - like this:
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Black and White
conversion in
Photoshop

Addition of Hue/
Saturation layer to
modify Black and
White conversion.
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Method 8 - Colour Blending
None of the monochrome conversion techniques described so far require anything
more than a fairly basic understanding of Photoshop. This is an advantage but also a
limitation. The limitation is that they do not allow you to harness a lot of the power of
Photoshop. This next technique allows you to gradually extend your use of some
additional features of Photoshop to produce an extremely versatile method of
monochrome conversion.
The basic steps in this process are:
1. Open the image in Photoshop.
2. Add a black, white or grey Fill Layer above the background image.
3. Change the blend mode of the Yill layer to “Colour”.
The result is an image that retains the luminance of the pixels in the original image but
uses the hue and saturation of the Yill layer. Since the hue and saturation for grey tones
are both zero, the colour blending removes all colour from the resulting image. You
might expect this to produce the same result as simply desaturating the image but it
generally does not, particularly for images that have highly saturated colours, as in this
example:

Colour blend

Desaturate

You can extend this approach by independently adjusting the contrast in the highlight
and shadows areas - as described in the “Monochrome - Colour Blending” tutorial on
my web site: www.roykillen.photography.
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Monochrome conversion in Adobe
Camera Raw (ACR)
This is similar to the Black and White conversion in Photoshop but there are some
important differences. There were some signiYicant changes in how monochrome
conversions are done in ACR version 10.3 (the conversion is now done form the “Basic”
panel rather than from the “HSL/Grayscale” panel).
Before attempting a monochrome conversion, make whatever adjustments are
necessary to exposure, shadows, highlights, etc.
At the top of the Basic panel, select “Black and White” as the “Treatment”. The “ProYile”
will then show as “Adobe Monochrome” and the image in the preview area will change
to monochrome.

You now have two options. The Yirst option is to
select the fourth icon from the left - if you hover
your mouse over it you will notice that its name
has changed from “HSL Adjustments” to “Black &
White Mix”. You will then see a set of sliders that
are similar to the Black and White sliders in
Photoshop. The main difference is that you now
have 8 sliders rather than the 6 sliders that are
available in Photoshop (Oranges and Purples
have been added and Cyans is now called Aquas.)
Adjusting these sliders allows you to alter the
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lightness of the various colours. When you are satisYied with the result you open the
image in Photoshop to continue your editing.
In both Photoshop and ACR there is a “default” setting (that sets all the sliders to zero)
and an “auto” setting that analyses the image and sets the sliders in an attempt to
maximise the number of shades of grey.
Whether you use the ACR monochrome conversion or the Photoshop Black and White
conversion you need to be prepared to analyse your image and make the adjustments
that will produce the result you are seeking. Relying on the default or auto settings in
either approach is unlikely to give you the best possible results. Further, the default
and auto settings in the two systems give different results as illustrated below:

Default conversion

Auto conversion

ACR

Photoshop

The important message here is that areas that are obviously different colours do not
necessarily translate into different shades of grey - the result depends on the ‘formula’
that the software is using to make the conversion.
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An alternative to changing the Black and White Mix (as described above) is to apply a
monochrome pro4ile. To the right of the proYile name
in the Basic panel there is an icon (4 squares) and
clicking on that opens the ProYile Browser to give you
access to a set of built in proYiles. (You can add other
proYiles or make you own if you want to). These
proYiles can be shown as a list or as a grid (which
shows thumbnails of the result of applying each
proYile).
As you move your mouse over each proYile name (or
thumbnail) the preview image changes and this
allows you to select an appropriate starting point for
your monochrome conversion. The following images
show some of the possibilities.
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Once you have selected a proYile, close the ProYile Browser and back in the Basic panel
you will see an “Amount” slider beneath the name of the proYile you have selected.

This allows you to apply a conversion that is the ACR default (Amount slider on zero)
or various amounts of the selected proYile.
In the Basic panel all the normal sliders (except for Vibrance and Saturation) will still
be available for adjustment. When you are satisYied, open the image in Photoshop.
IMPORTANT WARNING: If you convert an image to grayscale in ACR and then transfer it
to Photoshop, the image that opens in Photoshop contains no colour information - so you
cannot “Eine tune” it with any technique that relies upon colour information. You can, of
course, still make adjustments that do not rely on colour - such as brightness or contrast.

Monochrome conversions in
Lightroom
The process of monochrome conversion in Lightroom is similar to the process in
Adobe Camera Raw - but with one very important difference. If the conversion is done
in Lightroom the colour information is not lost - so the conversion can be reversed if
necessary. Lightroom uses both ProYiles and Presets as a means of converting images
to monochrome. ProYiles that are installed in LIghtroom are also automatically
available in ACR.
The basic process is:
1. Locate the image in the Grid view of the Library module.
2. Make a Virtual Copy.
3. Open the Virtual Copy in the Develop module.
4. Select Black & White as the Treatment.
5. Open the ProYile Browser by clicking on the ‘4 squares’ icon. You will then
see the same collection of proYiles that are available in ACR.
The Lightroom Develop module also contains a collection of presents that you might
like to use as a starting point for your monochrome conversion. They are located in the
Presets panel on the left of the screen. Some of these presets are deigned to produce
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effects that are similar to the use of analogue Yilters. For example, applying the ‘green
Yilter’ preset will lighten foliage and darken anything that is magenta.

Plug-ins for monochrome conversions
There are many plug-ins (small programs that are activated from within Photoshop or
LIghtroom) that can produce very good monochrome conversions. Three of the most
popular plug-ins are:
NIK - Silver Efex Pro
Topaz - B&W Effects
On1 Photo Raw - Black and White presets in the Effects module
Tonality presets in Luminar.
These plug-ins all incorporate a range of presets that can be used as a starting point for
your monochrome conversions.
Each one has advantages and limitations and there are plenty of tutorials on the web to
show you how to use them. My advice is to download free trial versions and try them.
The Tonality presets in Luminar (which can also be used as a stand-alone program)
have one very big advantage - you can use layers and masks to selectively apply
different monochrome effects to different regions of an image so you can ‘stack’
multiple presents and Yine tune each of them independently.
One advantage of plug-ins such as NIK Silver Efex Pro is that they can enable you to
fairly rapidly achieve dramatic conversions (perhaps several versions) that would be
very time consuming to attempt otherwise. This point is illustrated in the following
example.

Original and monochrome conversion using NIK Silver Effects Pro.
(c) Roy Killen 2019

Monochrome Conversions

Page 39

(c) Roy Killen 2019

Monochrome Conversions

Page 40

(c) Roy Killen 2019

Monochrome Conversions

Page 41

(c) Roy Killen 2019

Monochrome Conversions

Page 42

Which images best suit monochrome?
Almost any subject matter is suitable for monochrome images, but portraits,
architecture and landscapes are often good subjects to start with when you are
exploring different conversion techniques.
For monochrome landscape images, two factors will generally help to enhance the
image:
1. Lighting that produces deYinite shadows and highlights.
2. Strong surface textures.

Of course, there will be some images in which other factors are more important and
the following examples are intended to give you some ideas as a starting point.

(c) Roy Killen 2019

Monochrome Conversions

Page 43

(c) Roy Killen 2019

Monochrome Conversions

Page 44

Sometimes monochrome is not a good
option
You should not assume that every image is suitable for monochrome conversion. There
are two common situations in which retaining the colour will be a better choice. The
Yirst case is when the colour is critical to the message or story that you want the image
to communicate. For example, in this nature image removing the colour removes some
important parts of the nature story:

The second situation in which monochrome conversion may not be a wise choice is
when removing the colour removes or diminishes important details, such as in this
image:
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Some General Conclusions
Although it is sometimes possible to perform magic with your monochrome
conversions (see page 38 for one such example) you will get the best monochrome
results if you ‘get it right in the camera’ - exposure, composition, etc. Most importantly,
give yourself the best Yiles to work with by capturing RAW Yiles rather than JPEG Yiles.
When the dynamic range of the screen exceeds the dynamic range that your camera
can capture, expose for the highlights because over-exposed highlights tend to look
worse in monochrome than under-exposed shadows.
In general, the best results will be achieved when the colour image you are working
with has correct white balance (pixels that should be neutral grey actually are neutral).
So it is a good idea to try to remove unwanted colour casts before you start the
conversion process. However, there will be some occasions when altering the
Temperature or Tint sliders in the white balance section of Lightroom or Adobe
Camera Raw will enhance your monochrome images.
All of the monochrome conversion techniques described above (except for those done
with plug-ins) have a common limitation. They all apply the conversion globally
(across the whole image) and uniformly (applying the same mathematical formula to
the conversion of each pixel). For example, if you set the Channel Mixer to R=30 G=60
B=10 then that “mixing formula” will be applied to every pixel in the image regardless
of its hue, saturation or lightness. This may give you the desired result or it may not.
To achieve greater control over the Yinal result you need to be able to apply your
monochrome conversions selectively. This can be achieved with various standard
Photoshop techniques such as layer masks or with various Photoshop plug-ins.
Whatever conversion technique you use, it is always worth considering how you might
be able to Yine tune your result with some conventional image adjustments such as
curves or dodging and burning.
No monochrome conversion technique will be the best one to use with all your
images. Try to select the method that is the most suitable for the particular image that
you are working on and the ideas/feelings that you want to communicate with your
image. Making a choice will become easier as you gain more experience and
experiment with a variety of techniques.

If you have any comments or suggestions for improving these notes please email me.
Roy Killen
roykillen@mac.com
21 April, 2019
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